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1 Introduction
1.1 Preface

Warranty

Data backup

1.2 Documentation for PC software components

9499-040-76611 PC Evaluation software (PCA3000)

PCA3000 serves to visualize and evaluate process data (measurement data,
batch data, messages, device audit trails ...). The process data can be read in
via the CompactFlash memory card, or made available through the PCC
software.

9499-040-76711 PCA Communications software (PCC)

PCC is responsible for the data transfer from a device (e.g. paperless recorder)
to a PC, or within a network.

H If any difficulties should arise during start-up, please do not
manipulate the unit in any way. You could endanger your rights under
the instrument warranty! Please contact the nearest subsidiary or the
head office in such a case.

A

Make a regular backup of your configuration file.
If you reformat the hard disk, the setup will be deleted, including all
the settings, connection lists and archive data that were created! 
7



1 Introduction
1.3 Typographical conventions

1.3.1 Warning signs

Caution

1.3.2 Note signs

Note

Reference

Footnote

Action
instruction

1.3.3 Representation

Menu items

A

This symbol is used when there may be damage to equipment or
data if the instructions are ignored or not followed correctly!

H
This symbol is used when your special attention is drawn to a
remark.

v
This symbol refers to further information in other manuals, chapters
or sections.

abc1 Footnotes are remarks that refer to specific points in the text.
Footnotes consist of two parts:
A marker in the text, and the footnote text itself.
The markers in the text are arranged as continuous superscript
numbers.

h This symbol indicates that an action to be performed is described.
The individual steps are marked by this asterisk, e.g.

h Use OK to confirm

File ➔ Save as Small arrows between the words indicate a
sequence of commands which must be
performed one after another.
8



2 Installation
2.1 General

Intended 
application

The PCC software is used to manage the device list for a PC. It fetches time-
dependent data from various attached devices and can synchronize the
device time to the PC time. It is possible to fetch data simultaneously
(multitasking) from devices that are connected to different serial interfaces or
modems or via an Ethernet.

PCA3000 The data that have been fetched for further processing in the PCA3000
evaluation software are held separately for each device as: connection data,
time of fetching, and the storage location (archive).

2.1.1 Hardware and software requirements

The following hardware and software requirements have to be met for
installing and operating PCC:

Hardware - PC Pentium1 

- 64Mbyte main memory

- CD-ROM drive

- mouse

- one free serial interface, network connection, or USB interface for 
CompactFlash memory cards (depending on the type of data transmission 
to the device),

- 120Mbyte available on hard disk

Communication In addition, the following items are required for communication between the
PC and the device, such as:

- PC interface cable including adapter (only when using the Setup interface) 
or

- serial interface cable (when using the RS232C or RS422/485 interface) or

- network connection (when using the Ethernet connection).

Software - Microsoft Windows2 NT4.0, 2000 or XP

2.1.2 Hardware and software recommendations

- Windows 2000 operating system

- Pentium III

- 128Mbyte main memory

- 2Gbyte free space on hard disk for data

1 Pentium is a registered trademark of the Intel Corporation
2 Microsoft and Windows are registered trademarks of Microsoft Corporation
9



2 Installation
2.2 What is on the CD?

Software - PC Evaluation software (PCA3000)

- PCA Communications software (PCC)

- Technical documentation

License
number

Various license numbers are printed on the reverse side of the CD cover,
depending on what you ordered.
These numbers must be entered during the installation, or in the specific
program at a later time.
All the functions that were ordered can be enabled in this way.

H
If no license number (or an invalid number) was entered during
installation, then some functions of the corresponding software
(such as data transmission, saving of data, printout) will be
inhibited.
10



2 Installation
2.3 Starting the installation program

Run installation
program

h Start Microsoft Windows

h Insert the CD into the drive, then close the drive.

After the CD has been inserted, the installation program will start
automatically. If not, proceed as follows: 

h Start the file “Start.exe” in the main directory of the CD.

The installation program will lead you through the rest of the installation with
screen messages.

h Select the components that need to be installed.

A

The installation will not be carried out correctly unless the
following conditions are fulfilled:
1.) The user who is logged in during installation must be the same
as the one who will subsequently be working with the program.
2.) The user must have administrator rights during the installation.

H
If Microsoft Windows has already been started, all Windows
programs must be shut down before installing the program.

Software that is to be installed must be 
marked by a tick ( ).
11



2 Installation
h Now enter the required license numbers.

h Define the program folder into which the icons for starting the software are 
to be copied.
12



2 Installation
Starting the 
installation

h The selected software components will now be installed, by clicking on
  

h Conclude the installation with the  button.
13



2 Installation
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3 Operation
3.1 Starting the program
h Call up the program from the start menu

The start screen appears, with information about the installed version.

3.1.1 Logging in to the program

- The log-in is performed only when it has been activated by the user. It can 
be activated, for instance,through the function Extras ➔ Renew log-in / 
Alter password.

v Chapter 7.5.10 “Renew log-in / alter password”

- Some devices do not have a log-in to the program.
15



3 Operation
Password 
entry

h Log in to the program. Select your name (user ID) and enter the password.

h Click on .

Password 
alteration

v B 70.9703.0 PCS Chapter 4 “User list Assistant“
(for an enhanced security level).

After a pause:  
Start automatic 
operation

This window offers the option of not immediately starting automatic operation
when the program is started. This may be necessary, for instance, if work has
to be done on the device list before activities can commence for the listed
devices.

H
This dialog will not be initiated if the function “Automatic in
background” is active when the program is started.
v Chapter 7.4.2 “Automatic mode in background”

Automatic mode
– start immediately

Automatic mode
– do not start
16



3 Operation
3.2 Windows of the user interface

3.2.1 Moving and closing windows

The mouse can be used to adjust the window to the required size, or the
window for active devices can be closed completely.

Navigation tree
A tree structure showing 
all connected devices

Active devices window
A list of all the devices that are
active (in PCC) at present, e.g.

fetching data

Dialog window
The settings for the connected 
devices are listed here.
17



3 Operation
3.3 Device types
Devices with or without CompactFlash memory card.

H
The operating instructions below make frequent reference to
“Device type” 1 or 2 or to “Devices of type” 1 or 2.

Device type 1
Device type 1 is used to designate all devices that do not use a
CompactFlash memory card for fetching the data from the
device.

Device type 2
Device type 2 is used to designate all devices that use a
CompactFlash memory card for fetching the data from the
device.
18



3 Operation
3.4 Rights
As described in Chapter 3.1.1 “Logging in to the program”, a user must log in
with the correct ID and password when the program is started. As a result of
this log-in rights are allocated for the individual functions. So it is possible that
not all functions can be activated, depending on the user or type of
installation.

Right Demo
installation

Maintenance Specialist

Edit time settings - - X

Edit archive settings - - X

Print - X X

Edit interface settings - X X

Edit device settings X X X

Delete device - - X

Create new device X - X

Start automatic mode - - X

End automatic mode - - X

Pause transmission procedure - - X

Edit extras/options - X X

Edit global settings - X X

Place program in background /
bring to foreground - - X

View event list X X X

View error list X X X

Comment in audit trail - X X

Prepare device modem - X X

Enable program options X - X

Create new archive - - X

Read in time periods - X X

X = right is available
19



3 Operation
3.5 Navigation tree
The settings for the device list are made in the navigation tree, where the
individual devices (from which the data are to be read out) are entered.

Use the mouse to change the settings in the device list or to add a device to
the list.

Fold up tree ( )
and
fold down tree ( ).
20



3 Operation
3.6 Dialog window
The currently valid entries are shown in the dialog window. The dialogs for
altering the settings can also be called up in the dialog window.

Click on the arrows (by using the left mouse button when the mouse pointer is
positioned on an arrow) to open (fold down) and close (fold up) the current
parameter values.

Fold down / 
Fold up

Device list Use the right mouse button, or double-click on the device list, to change the
global settings.

v Chapter 4.1 “Editing the device list”

v Chapter 7.2.1 “Device list”
21



3 Operation
Device type
(device)

By using the right mouse button, or by double-clicking on a device, you can
change all the settings for the device. If the function “Use Assistant for device
settings” is active, then all the settings will be requested, one after another. If
the Assistant is not active, you will have to call up the various settings dialogs
by hand.

v Chapter 4.2 “Adding devices”

v Chapter 7.2.2 “Device type”

Device type
(parameter)

By using the right mouse button, or double-clicking on a parameter, you can
change a particular setting for the device. The function “Use Assistant for
device settings” is irrelevant in this case.

v Chapter 4.2 “Adding devices”

v Chapter 7.2.2 “Device type”
22



4 Device administration
4.1 Editing the device list

h Position the mouse pointer on “Device list” and press the right mouse 
button.

Global
settings

h Select the function Edit device list.

v Chapter 7.2.1 “Device list”

A new device
is entered in the list 
here.

Alter the global 
settings for the 
device list.

Descriptive text. This is shown in 
the dialog window, and also printed 
out.

Default directory for 
archive data that have 
been fetched.

Use the default 
directory (created 
within the PCA3000 
software) or specify a 
different directory.

Either “Use the Assistant for device settings” or enter 
everything by hand. 
If the Assistant is active, all the necessary
parameters will be requested, one after another.
23



4 Device administration
4.2 Adding devices

h Activate a device type by clicking on it with the mouse. 

h Start the menu function Edit ➔ New or left-click on the symbol ( ) in the 
toolbar.

The following text example assumes that the selected device is a paperless
recorder.

Select device

The function “Use the Assistant for device 
settings” must be set as active, and then, 
for example, this dialog will appear.

Alter device version
24



4 Device administration
You will now be led automatically from dialog to dialog, and can make all the
entries that are required for reading out data.

H
The function described here is based on an active “Assistant for
setting up connections” (default setting for a new software
installation). The Assistant can be switched off through the
function Device list ➔ Edit or by using the Setup or PCS software
within the device list.

If the option is active ( ), a check is
made at the end, whether the

chosen device can be accessed via
the selected interface.

Here you can decide whether the
device should be defined as the

default device ( ). The function is
only significant if the device is to be

accessed through the setup
software

or the PCS software

Select device type and version.

A descriptive text for the device can be 
entered here. The text will appear in the 
navigation tree.

The identifier is created by the 
computer. It is unique, and is, for 
example, entered in the PC audit 
trail.
It can be used in the PCAT software, 
if a filter is defined.
25



4 Device administration
Log-in to device Logging in to the device is only required for devices with internal user
administration. 

No log-in The default setting of the software is that a user who is logged in is
automatically logged in to a device that is found with the user’s name and
password, and can thus communicate with this device.

Set the option ( ) if you do not want to log in. Please note that it is possible
that some functions will not be operable if you are not logged in. The decisive
factor is the current user list and the access rights that are defined in this list.

Saving ID and 
password

If the option is active, the log-in to the device is made through the user ID and
password that are entered, regardless of who is currently using the PC
software.

In the following dialog window, you have to activated the  button to
select the interface which you want to use to access the device. 

Save ID and password

Do not log in.
26



4 Device administration
PC Communi-
cation interface

Available options are:

RS232 RS232

RS232 RS232 to
RS422/485
converter

RS232 Setup interface

Modem Modem - RS232

Modem Modem - RS422/485

TCP-IP
(Intranet / Internet)

Ethernet
27



4 Device administration
The next steps depend on the interface or type of connection that has been
selected.

Serial
interface

The following parameters must be selected.

TCP-IP
(Intranet / Internet)

TCP-IP to 
RS232/RS485
converter

Type: I-7188E series

TCP-IP
(Intranet / Internet)

TCP-IP-Ethernet to 
RS232/RS422/RS485
converter

Type:
W&T Com-Server

Connected to COM1, COM2 The PC interface to 
which the device is 
connected.

Transmission rate 9600, 19200, 38400 The transmission rate 
must match the one that 
has been set in the 
device.

Control signal RS232 If the RS232 interface 
on the device or an 
interface converter with 
an automatic transmit/
receive changeover is 
used.

RS232 setup interface
(TTL)

If the setup interface on 
the device is used. 

RS422-RTS If the RS422/485 
interface on the device 
is used.

Recommendation: Use 
a Spectra converter with 
an automatic transmit/
receive changeover.

RS422-DTR

RS485-RTS

RS485-DTR

Communications
protocol

Modbus TCP/IP,
Modbus protocol

Set the
Modbus protocol
here.
28



4 Device administration
Analog 
modem /
ISDN

The following parameters must be selected:

TCP/IP PORT The following parameters must be selected:

Device address 1 — 255 Device address for the 
Modbus protocol.

If the “RS232 setup 
interface” is used as the 
control signal, then the 
device address is 
ignored – it does not 
have to match the 
address in the device.

Telephone number Enter the telephone 
number for the required 
device. 

Connect via Select the modem that 
is to be used to make 
the connection. 

Communications
protocol

Modbus TCP/IP,
Modbus protocol

Set the
Modbus protocol
here.

Device address 1 — 255 Device address for the 
Modbus protocol.

IP address /
HOST name

xxx.xxx.xxx.xxx
(Example: 192.168.0.10)

Enter the IP address of 
your device. If you enter 
the name, the IP 
address can be 
determined by clicking 
on the button “Convert 
HOST name to IP 
address”.

Port number,
port name

502 The port used for 
communication.

Communications
protocol

Modbus TCP/IP,
Modbus protocol

Set the
Modbus TCP/IP
here.
29



4 Device administration
TCP/IP PORT
(ICPDAS 
7188E1-8)

The following parameters must be selected:

TCP/IP PORT
(W&T)

The following parameters must be selected:

IP address /
HOST name

xxx.xxx.xxx.xxx
(Example: 192.168.0.10)

Enter the IP address of 
your converter. If you 
enter the name, the IP 
address can be 
determined by clicking 
on the button “Convert 
HOST name to IP 
address”.

Serial port COM1, COM2, ... Serial port of the 
converter, to which the 
device is connected.

Transmission rate
(baud rate)

9600, 19200, 38400 Transmission rate 
between converter and 
device. It must match 
the one that has been 
set in the device.

Control signal None If the RS232 interface 
on the device is used. 

RTS permanent

RTS changing

IP address /
HOST name

xxx.xxx.xxx.xxx
(Example: 192.168.0.10)

Enter the IP address of 
your converter. If you 
enter the name, the IP 
address can be 
determined by clicking 
on the button “Convert 
HOST name to IP 
address”.

Serial port A, B, C, D Serial port of the 
converter, to which the 
device is connected.

Transmission rate
(baud rate)

300, 600, 1200, 2400, 
4800, 9600, 14400, 
19200, 38400, 57600

Transmission rate 
between converter and 
device. It must match 
the one that has been 
set in the device.
30



4 Device administration
After selecting the interface, the next step is to make the entries for the time
settings (for the automatic read-out of data) and the archives (folders and
names of the files in which the data are to be stored).

Control signal RS232 If the RS232 interface 
on the device is used. 

RS232 setup interface
(TTL)

If the setup interface on 
the device is used. 

RS422-RTS If the RS422/485 
interface on the device 
is used.

Recommendation: Use 
a Spectra converter with 
an automatic transmit/
receive changeover.

RS422-DTR

RS485-RTS

RS485-DTR

RS232/RS485
adapter cable

Only for internal
test purposes.

H
Making the connection via the setup interface only works with
devices that have the Modbus protocol available at this interface. 
31



4 Device administration
Time
settings

h Left-click on the  button, and then you can enter the time for 
the automatic read-out.

v Chapter 5 “Time settings”

Click on OK when the times 
have been set.
32



4 Device administration
Archive

h Left-click on the  button, and then you can alter the settings for the 
archive (file name and directory).

v Chapter 6 “Archive”

Click on OK when you have 
finished the archive settings.
33



4 Device administration
You will then get a summary for the new device.

h Complete the adding of a new device by clicking on the  button.

The device should now be set up and ready for reading out data. If you want
the device to read out data automatically, then automatic mode must be
started. It is started through the menu function Automatic ➔ Automatic mode.
34



4 Device administration
4.3 Changing the settings

h Position the mouse pointer on the  symbol and press the left mouse 
button.

The tree in the navigation window will now be folded down.

h Position the mouse pointer on the parameter that you want to change, and 
press the right mouse button.

h Select “... edit”. The dialog for alteration will be opened, depending on the 
selected parameter.
35



4 Device administration
v Chapter 5 “Time settings”

v Chapter 7.2.3 “Editing”
36



5 Time settings
The menu for setting the times for fetching the data can be accessed

- when a new device is set up or 

- by means of the menu function Edit ➔ Edit times.

In the latter case, the “Times” field has to be selected in the navigation tree.

In the “Time settings” dialog, you can set the cycle types for fetching data,
synchronizing clocks, operating times for each day of the week, and the
settings for the response to an error. Here you can also make settings to define
the read-out and evaluation of the data.

A

When using an Ethernet connection via TCP/IP, only one program
from the PC software components can operate through the interface.
But other programs can still continue to communicate with other
devices.

Example:
PCC is used to access a paperless recorder (Device 1) via TCP/IP.
PCS (Security Manager) can be used to access a different paperless
recorder (Device 2) via TCP/IP.
37



5 Time settings
Cycle type: 
periodic

Defines the type and method for fetching or reading out raw data.

H
If the period is set to less than 60 seconds, the data are read out in
a continuous cycle, i.e. the connection to the device is never
broken.

A continuous cycle is only stopped if an error occurs, on
cancellation by the user, or at the end of the operating period (if it
is active and the read-out has been carried out 100%). The
parameter for “Continue read-out beyond the operating period” in
the register “Expanded (1)” also has an effect on the end of the
operating period.

Active ( ):
The data will only be read, the memory 
alarm is not affected

Setting for fetch intervals:
The settings “2” and “hours” mean:
data will be fetched every 2 hours

Inactive ( ):
The time interval only starts to run when 
the read-out procedure is finished.
Active ( ):
The time interval starts to run at the start
of read-out.
If the read-out takes longer than the time 
interval, then the next whole multiple of 
the interval is used.

Operating period: active
Inactive ( ):
The operating period is the relevant factor for the time interval. At the end of the 
operating period, the remaining time of an interval is carried forwards to the start of 
the next operating period.
Active ( ):
At the end of the operating period, the interval continues in a 24-hour rhythm.

Operating period: inactive
If the operating period is inactive, this function has no effect.

The following functions 
are available:
38



5 Time settings
Example 1 The interval for fetching is: every 2 hours during the operating period from
08:00:00 AM to 06:00:00 PM, with the setting “Immediate”. In this case, the
operating period can be divided by the time interval.

Example 2 The interval for fetching is: every 2 hours during the operating period from
08:30:00 AM to 05:30:00 PM, with the setting “Immediate”. In this case, the
operating period cannot be divided exactly by the time interval. So the fetch
times for the following day will be shifted accordingly.

When data is fetched for the 10th time, the start time will have come round to
09:05:32 again.

H If the option “Use period as absolute time” was active ( ), then the
behavior would not change, since both the operating period (10
hours) and a complete day (24 hours) can be divided by the time
interval (2 hours).

actual time
09:05:32

11:0 :325 13:0 :325

15:0 :325

17:0 :325
time
operating period 08:00 to 18:00

H If the “Use period as absolute time” option was active ( ), then the
behavior for read-out would be as described above, for Example 1. 

actual time
09:05:32

2. 3.

8.

5.time for fetch
operating period 08:00 to 18:00

6.

7.

4.

9.
39



5 Time settings
Cycle type:
daily,
cycle type:
weekly,
cycle type:
monthly

Start time for next read-out of data

No change
If a change is made to the time settings, the new time will only take effect after the 
next read-out.
Example: Read-out is set to take place on Mondays, at 08:00. It is now 07:00 on 
Monday. You set “Fetch at” to 10:00, and leave the “Calculation of start date” set to 
“No change”. The next read-out happens at 08:00. Then, the new setting will be 
made: for 10:00 on Monday of the following week.
Next valid date
Depending on the setting, this is the next full hour, minute, or day – at 00:00:00.
Immediate
This takes the present day/time as the starting date, after which the new time is 
calculated from the current setting. Caution: If the present time is outside the 
operating period, there will be no read-out.

Time
for daily, weekly or monthly

Weekday
for weekly or monthly
40



5 Time settings
Time
synchronization

The setting for when the device time is to be synchronized to the PC time. This
is used to eliminate differences between the PC and the device.

Cyclic 
check

This defines a check for whether the attached device is still connected to the
PC. If a device is not accessible, then an error message is entered in Audit Trail
Manager.

This function is intended to reveal any possible connection error before the
data read-out takes place. 

H
It is only possible for devices that support time synchronization.

H
Synchronization can only be performed during operating periods.

whether and how the start date/time is calculated

H
The check can only be made during the operating period
(when the operating period is active).

Setting for how frequently 
the connection should be 
checked.
41



5 Time settings
Operating 
periods

Here you can set for which periods of time the device is accessible, i.e. the
system is in operation. These settings are used to calculate the start dates/
times for activities (e.g. fetching or reading out data, time synchronization, and
cyclic checks) and in this way also reserve specific time periods for other
programs.

Daily times These settings are intended for use when data need to be fetched or read out
at a specific time of day.

The time of 
day from ... to 
... when the 
device is 
operational

Weekdays on 
which the 
device is to 
be 
operational

A

These times must lie within the operating periods, and
the action (fetching/reading) must be set to daily!

Enter time

List for the 
special time 
entries

The selected entry is removed from the list 
and presented for editing in the time field.

Adds the date/time that is set to the list.
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5 Time settings
Time schedule These settings are intended for use when data need to be fetched or read out
at individually specified times that cannot be set to occur periodically.

A

These times must lie within the operating periods, and the action
(fetching/reading) must be set to schedule! After the processing of a
scheduled event, it will be removed from the list by the software.

List for the 
special time 
entries

Enter 
date and 
time

The selected entry is removed from the list 
and presented for editing in the date/time 
field.

Adds the date/time that is set to the list.
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5 Time settings
Expanded (1)

A

This function depends on the device version!

 % of data 
not yet 
fetched
(only for
Type 1 
devices)

 Response
to error

Active ( ):
The mark that data have been fetched 
will only be set when the read-out 
procedure is finished (only for Type 2 
devices).

Active ( ):
In the event of an error, a single repeat is carried out. Further 
attempts at reading will not be made until the next scheduled 
time.

Inactive ( ):
All data will be read out from the device. For Type 1 
devices it can happen that a memory alarm is generated 
during the read-out. After a successful read-out, the 
alarm will automatically be reset.
Active ( ):
Only new data will be read, even if “old” data are 
missing in the archive.

Active ( ):
If the operating period ends, an existing read-out 
procedure continues until all the data have been fetched.
Inactive ( ):
If the operating period ends, an existing read-out 
procedure is cancelled (after the current data block has 
been completely read out).

Active ( ):
In the event of an error, repeats are permitted even though 
they are made outside the operating period.
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5 Time settings
Expanded (2)

Active ( ):
The scheduled times are calculated from the next valid 
point, as if the PCC software had just made a read-out.
Inactive ( ):
Data that have not yet been read out (from devices 
where the scheduled time has passed) are read 
immediately, and then the scheduled times are 
recalculated (see register for operating periods).
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5 Time settings
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6 Archive
The menu for setting the archives for the data fetched can be accessed

- when a new device is set up or 

- by means of the menu function Edit ➔ Edit archive.

In the latter case, the “Archive” field has to be selected in the navigation tree.

After calling up this function, the default archives that have been set will
appear, and the other functions will be grayed out (not selectable).
A new archive can only be set if the tick mark is removed by clicking. You can
select any directory and/or archive file that have the *.177 file name extension.

Tip It is a good idea to have several archive files if the data are to be stored both
on your own PC and on a server, using a regular data backup procedure. For
instance, an additional archive could be provided for company-wide access.
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6 Archive
Archives for 
automatically read
data

Archives for manually 
read data

Current default archive (directory)
v Chapter 7.1.4 “Default settings”

Active ( ):
Accepts each data block individually for evaluation, directly after reading 
out.
Inactive ( ):
All the entire data in the archive that are no yet in evaluation (e.g. previously 
read data, or data from a CF card) will only be evaluated at the end of 
reading out.

Active ( ):
Data are immediately accepted for evaluation.
In PCA3000, this means that the archives will be opened faster.

A click with the 
left mouse button 
starts the 
PCA3000 
software and 
brings up the 
archive data in 
the display. 
If there are 
several archive 
files in the 
directory for a 
device, then the 
first archive that 
is found will be 
used.

Archives for manually 
read data

A

Archive directory
Data are stored in all the archive files with the same device identifier (Serial 
No.). If there is no archive, a new one will be created.
File name = device identifier
Archive file
Data will only be stored in this archive. The archive must have the same 
device identifier as the device itself. If the archive does not match the device 
and a suitable existing archive cannot be found, then a new archive will be 
created.
If, for instance, it is not possible to store data on a network, then they will be 
stored in the default archive.
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6 Archive
If the standard (default) archive paths (one or both) are inactive ( ), then the
dialog changes, e.g. to:

Tip If you click a second time on an entry (not a double-click), then you can edit
the archive name and the directory as text.

Tip If you enter a name without defining a path (e.g. Manual01.177), then an
archive with this name will always be created or used in the default directory.

The default 
archive for 
manual 
read-out 
has been 
inactivated.

Start PCA3000 and display the data.
The marked archive will be opened. If it is a directory, then the

first archive that is found will be opened.

Add another archive for
manually read data.

Edit archive entry for manually
read data.

Remove an archive from the list.

Double-click on it
in order to be able

enter the name
directly.

A

When making a manual entry, please note that the file name extension
must always be “177”. If this rule is not followed, then it will not be
possible to store data in the intended archive.
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6 Archive
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7 Menu functions and toolbar
7.1 File

7.1.1 Export as RTF text

This function exports the information in the dialog window as an RTF text in
the file to be selected.

7.1.2 Print, print preview

This function prints all the connection data for the devices that are marked in
the diagram in the dialog window. 

Select what is 
to be
printed
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7 Menu functions and toolbar
Print preview

7.1.3 Printer setup

This switches to the list of the printers that are installed on the PC.
52



7 Menu functions and toolbar
7.1.4 Default settings

Default
settings

h File ➔ Default settings

h Set the required language

Here you can change the language used for the PC programs.
But the change only becomes active after a fresh program start. 

7.1.5 List settings

Right-click on 
the device list

A tick mark means 
that this bar or line is 
visible 

If this tick mark is 
set, the Assistant for 
device settings is 
activated.

Click the tick mark to 
be ON, if you want to 
use the same archive 
as for PCA3000

Click here to select a different archive (instead of the
default archive for PCA3000) or to enter the name

directly in the field

You can enter 
additional 
information on the 
list in this field
53



7 Menu functions and toolbar
7.1.6 Cancel

This terminates the program immediately after any current activities, such as
reading out data, have been completed. During the time that elapses until all
activities have been completed, no new activities will be started. Activities of
connected devices can also be cancelled. In this case, the program is
immediately terminated.

If any devices are still active after clicking on the  button (e.g. data
are being read out), then the following dialog will appear.

Select “Cancel” and then “Stop all” to terminate the software immediately.

A
If a data transfer is cancelled prematurely, then some data will be
missing from the archive. You must make sure that the data have
been fetched from the devices in good time, before a loss of data
occurs.
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7 Menu functions and toolbar
7.2 Editing
The entry in the navigation tree defines which of the functions Edit, Remove,
New and Duplicate are available.

Device list If the device list item is active, then the following functions are available.

v Additional information can be found in Chapter 7.2.1 “Device list”.

Device type If a device type is active, then the following functions are available.

v Additional information can be found in Chapter 7.2.2 “Device type”

Device If a device is active, then the following functions are available.

Lower level
for a device

If the lower level for a device is active, then the following functions are
available.

v Additional information can be found in Chapter 7.2.3 “Editing”
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7 Menu functions and toolbar
7.2.1 Device list

Edit device list h Edit ➔ Edit device list (or press function key F4)

The entry marked in the tree structure will be edited.

v Chapter 7.1.5 “List settings”

Remove h Edit ➔ Remove (or press the “Del” key)

This removes a connected device from the device list.

h Click on “Yes” to remove the entry from the device list.

Duplicate h Edit ➔ Duplicate (or press “Ctrl” + “Insert”)

The device that is marked in the navigation tree will be copied, and added to
the device list as a new entry. This entry can be freely modified.
A new identifier is created for every device entry, and so it is different from the
device that was copied. Events and errors are not copied, but automatically
set up as new entries.

v Chapter 7.2.2 “Device type”

H
This function is particularly suitable as a time-saver for entering
devices that are similar, with only small differences in the
connection data.
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7 Menu functions and toolbar
7.2.2 Device type

New
(using the 
Assistant)

h Edit ➔ New (or press the “Insert” key)

This adds a new device to the device list.

v Chapter 4.2 “Adding devices”

New
(without 
Assistant)

h Edit ➔ New (or press the “Insert” key)

New devices can also be added to the device list without using the “Assistant
for setting up connections”.

When you have called up the function, the following dialog window will
appear:

Unlike the operation with the Assistant, you will not be led sequentially from
one parameter to another, but will have to start the individual dialog windows
yourself.

7.2.3 Editing

Edit connection h Edit ➔ Edit connection (or press the F4 function key)
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7 Menu functions and toolbar
The log-in options have already been described on Page 26.

If you click on the  button, you can alter the settings for the
communications connection.

Edit times h Edit ➔ Edit times (or press the F4 function key)

v Chapter 5 “Time settings”

The “Return call” function is only 
available for specific device types with 
an active modem connection. Here you 
must enter the number of the PC that is 
to be called by the device.
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7 Menu functions and toolbar
Edit archive  h Edit ➔ Edit archive (or press function key F4)

v Chapter 6 “Archive”

Edit events h Edit ➔ Edit events (or press the F4 function key)

The “Events” list is intended for fast diagnosis and checking. The events that
have been entered here can be deleted. But deleting has no effect on the Audit
Trail entries.

The number of entries is limited. If the maximum number is exceeded, the
program will delete the oldest entries.

Edit errors h Edit ➔ Edit errors (or press the F4 function key)

The “Errors” list is intended for fast diagnosis and checking. The errors that
have been entered here can be deleted.

The number of entries is limited. If the maximum number is exceeded, the
program will delete the oldest entries. You can use the PCAT software to view
all the entries.

Two bell symbols are included in the toolbar and used in conjunction with
errors.
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7 Menu functions and toolbar
The green bell is active if a new error occurs in the device that is marked in the
navigation tree.

The red bell is active if a new error occurs in any of the devices. If errors occur
in more than one device, then the bells remain active until you have looked at
all the errors.

7.3 Data transfer

7.3.1 Reading out raw data (manually)

Depending on the device that is used, various details will have to be entered
for reading out raw data.

Recorders For the recorders (device type 2) you can define which data are required from
the device.

First, the software establishes a connection to the device.

You can close the dialog (or move it) and carry on working through the PCC
software. When the connection has been established, the data selection
follows. Every alteration of the configuration requires a new entry to be made
in the list.

If, for instance, the configuration of a measurement input is changed, then a
new entry has to be made, because different measuring ranges require
different scalings in PCA3000.

h Select the required entry from the list, and set the time limits, if necessary.

H
The number of different devices with fresh errors is limited.

H
The value for the memory alarm is not affected, i.e. the data will be
read out, but not marked as “fetched”!
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7 Menu functions and toolbar
v Additional information about using the data selection dialog can be found in
the PCA3000 Operating Manual.

The archive is selected here.

Active ( ):
After reading out the data, the evaluation software 
PCA3000 will  be started automatically.
The first archive that is found will be opened, depending 
on the settings described under “Edit archive” on 
page 59.
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7 Menu functions and toolbar
7.3.2 Fetching raw data (manually)

The device checks which data have not yet been stored in the archive that has
been set. This command transfers just these outstanding data to the archive.

h Click on the icon
The outstanding data will be transferred to the selected archive in the PC.

H
The value for the memory alarm is reset and marked as “fetched”!
For Type 1 devices, you must take note of the register Times ➔
Expanded (1) (Page 44).

H
Device type 2
Depending on the time taken for reading out and the speed of
storage, it is possible that data have been recorded after the start of
reading out, but not yet been read out themselves. These data will
be fetched by the next read-out procedure.

Device type 1
Data that have been recorded after the start of reading out will be
fetched by the next read-out procedure.
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7 Menu functions and toolbar
7.3.3 Cancelling the procedure

The currently active procedure for the device that is marked in the tree
structure will be cancelled immediately.

Cancel 
automatic
mode

If you want to cancel the read-out of data in automatic mode, then the
following dialog window will appear:

Click on  to cancel the reading out of data. Make sure that the data
have been fetched in good time, to avoid a loss of data. Select the period
during which the device will remain inactive. Automatic mode will only restart
for the selected device when this period has elapsed.

Cancel manual
read-out

If a manual read-out is cancelled, all that appears is the following warning
message:

Click on  to cancel the reading out of data.

The procedure that was cancelled will
be resumed at the earliest after this

time has elapsed. The automatic mode
must remain switched on!
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7 Menu functions and toolbar
7.4 Automatic
The scheduled times and activities that have been set up under “Times” will
only be automatically processed in the automatic mode.

7.4.1 Starting/stopping automatic mode

started If automatic mode has been started, this can be recognized by the depressed

representation of the icon .

stopped If automatic mode has been stopped, this can be recognized by the icon being

shown as normal, i.e.not depressed .

Changeover 
started/
stopped

The changeover between started and stopped is made through the menu
function Automatic ➔ Automatic mode or by a single left-click on the

corresponding symbol .

7.4.2 Automatic mode in background

This closes the current program window and places the PCC icon in the
system tray of the task bar at bottom right. The program carries on running in
the background.

If the program is ended and then restarted, it carries on in the background, as
shown in the picture. If the PC is restarted, then PCC is also automatically
restarted (after the log-in to the operating system).

h If you click on the icon, a window is opened.

h Click on “Program in foreground” and then (after a successful  log-in by the 
user) PCC will open up the menu window to its full size.
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7 Menu functions and toolbar
7.4.3 Stopping active devices

This function terminates automatic mode (if it was active when the symbol was
activated) and cancels all currently active data transmissions.

Message for
active 
automatic 
mode

Cancel
current
transmissions

A
If a data transfer is cancelled prematurely, then some data will be
missing from the archive. You must make sure that the data have
been fetched from the devices in good time, before a loss of data
occurs.
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7 Menu functions and toolbar
7.5 Extras

7.5.1 Enabling program options

You can use this function to enable additional software options, or to license a
software that was installed as a demo version.

h Extras ➔ Enable program options

h Enter the license number and click on “Registration”

7.5.2 Forgotten the license number?

Registered
license 
numbers -
click here

h Click on Info ➔ Registered license numbers

Your license numbers for the installed software components will now appear.
Various software modules can be enabled, depending on the license number.

A

After successful registration, the program must be closed and then
restarted, so that the newly enabled options can be activated.

No restart of Windows and no deinstallation is required!
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7 Menu functions and toolbar
7.5.3 Compressing the device list

This removes unused areas that have developed in the database  (device list) –
for instance, after deleting devices. If large gaps are present, compressing the
device list will reduce the time taken to load and save it. 

7.5.4 Resetting the device list

All the devices in the connection list will be deleted. None of the devices can
be active, i.e. reading out at the moment, not even for a different program
(Setup or PCS).

7.5.5 Synchronizing the device time

This function is only available for devices that support synchronization.

Synchronization is only possible if the time difference between the PC and the
device is not larger than 30 seconds.

System requirements means that synchronization is only effective for
differences >1 second. The residual error is <±1 second. After long periods of
connected operation (e.g. when using the Ethernet interface) the deviation can
rise to 2 seconds.

7.5.6 Changing the device password

This function is only available for devices that have user/password
management.
This function provides the option for altering the password at the device itself
or via the interface – because of the remote location of the device or as a
comfortable method that does not require detailed knowledge of operation. 

H
The function is appropriate if the device is operated at a remote
location, via Ethernet or a modem, or the user does not otherwise
have adequate knowledge of the system.
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7 Menu functions and toolbar
7.5.7 Searching for device

This function is used to search for connected devices on the interfaces that
have been set up.

A device that has been found will be added to the list if:

- the connection settings have not yet been used
(e.g. for another device address or another baud rate) or

- the device identifier cannot be matched to any of the existing entries in the 
list.

H
By pressing the Shift or Ctrl key and the left mouse button you can
search through several interfaces for connected devices using one
or several baud rates. Depending on the setting, the search
procedure may take some time.

A

When using the connection via the setup interface, no search should
be made through an address area, since the search could find a
device and make an entry for every address, even though there is
only one device connection. Some devices ignore the device
address on the setup interface.

Depending on the communication interface that is used, the
appropriate valid dialog will be brought up on the screen. The
example shows the dialog for using the serial interface.

The search covers the 
addresses 1 to 255 for 
the COM1 and COM2 
ports.
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7 Menu functions and toolbar
7.5.8 Device modem

It often turns out that the device and the modem are fitted with Sub-D socket
connectors. The modem cable, on the other hand, has one male and one
female connector. For this reason, please use the optional, preassembled
cable (Part number 9407-799-00801) when using one of the modems
recommended below.

Since many modems use RS232 signal levels, an RS422/485 converter is also
required if RS422/485 is used for the device.

Recommended 
modems

If other modems are used for the device, it may be necessary to alter the
initialization string. However, it is not possible to guarantee that the connection
will work. No support is available if other modems are used.

 TM2 33.6
Analog
industrial modem

Desktop device

HSM 33.6
Analog
industrial modem

for mounting on
DIN rails

HSM ECO TA
ISDN
industrial modem

for mounting on
DIN rails
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7 Menu functions and toolbar
7.5.9 Preparing the device modem

This function is used to prepare (initialize) a modem so that it can be
connected as a device modem.

h Connect modem to PC via a standard modem cable.

h After entering the settings, click on Transmit. When the the settings have 
been sent, a result message for the initialization appears.

h Detach the modem from the PC and cable it up correctly to the device 
interface.

The init (initialization) string for
the connected modem is
selected here.

Connection
These settings
must match those in the 
device quite precisely.
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The init string is
transferred to the
connected modem.

Only when
the

customized
“Initstring” is

active will
most of the

buttons on the
right-hand

side be made
available.

Alter init string
Create init string

Delete init string

Save alterations

adds to the list
of the 
customized
init strings the
original 
initstrings as wellAlter sequence

of the init strings
(modem list)

The modem responses during
transmission appear here.
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7 Menu functions and toolbar
If the modem responses includes texts such as “Error”, then the modem failed
to understand one of the commands. You will have to correct the command or
use a different init string.

After the software has been installed for the first time, the standard init strings
(one string per modem) will be copied and treated as the “customized” strings.
In this way, any altered init strings will also be retained after a software update.
This function means that the original strings can be attached to the
“customized” ones, with the result that the modem list grows every time the
function is called up.

Interface 
converter

If the device uses an RS422/485 interface, then the device modem must be
connected to the device via an interface converter (Spectra I 7520A/ISA) that
converts RS232 to RS422/485 levels.

h Connect the device to the telephone network, via the Spectra interface 
converter and the modem, as per wiring plan.

h Switch on the modem.

h Establish the new connection to the device via the modem.

v Chapter 7.2.1 “Device list”

Reset modem This resets the modem to the factory defaults, so that it can be used as a PC
modem again.

h Select a modem init string with the addition “Reset”.

H If a different interface converter is used, then it must be equipped with
an automatic data direction sensing function. 
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7 Menu functions and toolbar
7.5.10 Renew log-in / alter password

This is a standard dialog that helps to protect all components of the PC
software from unauthorized access. The software uses the log-in dialog for
mandatory identification via the password. 

Cancellation or an incorrect password invalidates all the rights for the user. For
security reasons, even ending the program is only possible after entering the
correct password.

Exception If automatic mode is switched off and no devices are active, then the program
can be ended.

Password
activation

For devices without an enhanced security level, the function Renew log-in /
Alter password is used to

- activate the user and password query at the program start and

- alter the current password.

This function only affects the operation of the software and not any device
user list that may be present.

Activation of the user and password query at the program start

When the software is first newly installed, there will be no query of the user
name and password. Your are automatically logged in as “Specialist” with a
blank password.

Proceed as follows:

h Start function “Renew log-in / Alter password”.

h Show options.

Show options.
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7 Menu functions and toolbar
h Activate option “After log-in – alter password” and click .

h Enter passwords - the “Old password” field remains empty.

When the entry has been concluded, the new password is activated by

clicking . From now on, the user name and the password will be

requested at the program start.

Password alteration
Altering a password is very much like activating password administration. The
only difference is that the “Old password” field must not remain empty.

H
No start password is initially assigned to the “Maintenance” user
either. At program start, log in with the “Maintenance” user name
and enter a password as described above.
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7 Menu functions and toolbar
7.5.11 Comment in audit trail

This creates an entry in the PCAT for the better understanding of the activity
that has been performed.

7.5.12 Start audit trail

This function starts the PC Audit Trail software.
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7 Menu functions and toolbar
7.6 View

7.6.1 Update

This updates the display on the screen. 
If devices are added to the device list, e.g. through the Setup software, while
PCC is active, then this function adds the devices to the user interface of PCC.

Deleted devices will only be removed when they are inactive, i.e. no data is
being transferred.

7.6.2 Active devices

Here you can show or close the window for active devices.

v Chapter 3.2 “Windows of the user interface”

7.6.3 With numbers

This inserts an unambiguous ID number in front of every device name. This
makes it easier to find a device if names are duplicated. Once it has been set
up, this number is also used in the audit trail entries.
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7 Menu functions and toolbar
7.6.4 Minimize/maximize all

All the settings shown in the dialog window are folded up (no detail view) or
folded out (detail view).

7.6.5 Filter

The filter function can be use to filter out settings in the dialog window.
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7 Menu functions and toolbar
7.7 Info

Info on PCC Here you can obtain information on the version number of the program. Please
have this number available if you have technical problems or queries and
contact a service representative.

Activating the  button will provide you with additional information
on any PC software components that may be installed. Please have these
numbers available as well, if you have technical problems or queries and
contact a service representative.

Registered
license
numbers ...

Here you can obtain information on the license number of the program. Please
have this number available if you have technical problems or queries and
contact a service representative.

Program
folder

Your program data are saved here, on the hard disk.

Supported 
devices

Information about the devices with which this software will function.

here are the
programs

here is, for instance, 
the device list

here are the 
customized
data, such as
modem strings

xx means that these positions will not be
evaluated in the event of a version check

(e.g. 172.01.05 is just as valid as
172.01.01
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8 Device-specific data
8.1 Paperless recorders (KS3010 und KS3012)

8.1.1 Identifying the interface

Which interface is implemented in the paperless recorder can be requested via
the menu Device info r Interface.

KS3010

KS3012
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8 Device-specific data
8.1.2 Connection diagram

Rear view of the 
paperless 
recorder

Example: KS3010 (also valid for KS3012)

Connector 20

Interface RS232 RS422 RS485

Connection 
diagram

H
When connecting the serial interface, please make sure that
connectors 20 and 21 are not mixed up. Connector 21 is reserved
for the PROFIBUS-DP interface (available as an extra).
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8 Device-specific data
Rear view of the 
paperless 
recorder

(only for KS3012)

Connector 22

Interface Ethernet

Connection 
diagram

1 

2

3

6

TX+ Transmit data +

TX- Transmit data -

RX+ Receive data +

RX- Receive data -

8

1
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8 Device-specific data
Rear view of the 
paperless 
recorder

(only for KS3012)

Connector 23

Interface Setup interface

Connection 
diagram

Connection only possible with 
“PC interface cable with TTL/RS232 converter 

and adapter (socket)”
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8 Device-specific data
8.1.3 RS232

In case of the RS232 interface, the handshake lines (RTS, CTS) are not used.
The RTS line from the master (CTS on the recorder) will be ignored, the answer
will be sent by the recorder immediately. The CTS line of the master (RTS on
the recorder) remains open. If the master evaluates the handshake lines, they
must be bridged in the cable.

8.1.4 RS422/RS485

The changeover between the RS422 and RS485 interfaces is performed
automatically by the recorder according to the connection type (2-wire or 4-
wire connection).

H
We recommend using a screened and twisted connection cable. 
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8 Device-specific data
8.1.5 Ethernet

If a PC is directly connected to a recorder via the Ethernet interfaces, a
standard crossover cable can be used. 

In all other cases, the connection is dependent on the network or connection
type used (Internet, Intranet, ...).

8.1.6 Setup interface

If the setup interface is used, the “PC interface cable with TTL/RS232
converter and adapter (socket)” must be used.
84



9 FAQs
FAQ 1 Why can’t I see new devices, that I created with the Setup software, in the
PCC software (which had already been started)?

Answer Click on the menu function View ➔ Update – the PCC software will then
accept the new devices.

FAQ 2 What is the difference between “Fetch raw data” and “Read out raw
data”?

Answer “Read out raw data ” does  not affect the memory alarm of a device. But
“Fetch raw data ” does affect the memory alarm. After the data have been
fetched, any memory alarm that is present will be cancelled.

FAQ 3 Why do some devices with Type 1 memory set the memory alarm during
the read-out of raw data?

Answer In the navigation tree, activate the option “Only read data that have not yet
been fetched” in the setting for “Times” in the “Expanded” register.

Caution: When using manual read-out, you cannot make any further selection
of the quantity of data in this way.

FAQ 4 What is meant by Device Type 1 and Device Type 2?

Answer Device Type 1 means devices that do not have a CompactFlash memory card
for fetching the data from the device.

Device Type 2 means devices that use a CompactFlash memory card for
fetching the data from the device.
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FAQ 5 How can I find the file with the measurement data, if the Archive is only
set as a directory, and no file name has been set?

Answer The name will be assigned automatically, and is derived from the device
identifier and a serial number.
If there are one or more files with a different name, that already contain data
from the required devices, then the first file that is found will be used. A new
file will not be created.

Open the archive settings and click on the PCA button ( ). This
automatically opens the PCA3000 software with the correct archive (PCA3000
must be already installed).

v “Edit archive” on page 59

FAQ 6 Why can’t I activate the buttons for reading out data from a device,
although the device is not shown in the “Active devices” list?

Answer The device is being used at the moment by a different software program (e.g.
the Setup or PCS software).

FAQ 7 Can the setup interface be used on all devices for reading out data?

Answer No, establishing a connection or reading out data via the setup interface only
works with devices that have the Modbus protocol available at this interface. 
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